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Safety Instructions • English

WARNING: This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within the 
product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT : Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du produit 
d’une tension électrique dangereuse susceptible de provoquer un choc 
électrique.

ATTENTION : Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site 
Extron, www.extron.com.

Sicherheitsanweisungen • Deutsch

WARNUNG: Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in der 
im Lieferumfang enthaltenen Dokumentation besonders wichtige Hinweise 
zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA: Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN: Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron,www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ: Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению электрическим 
током.

ВНИМАНИЕ:  Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций 
по эксплуатации и обслуживанию в руководстве, 
прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других 
вопросах см. руководство по безопасности и соблюдению 
нормативных требований Extron на сайте Extron: www.extron.com, 
номер по каталогу - 68-290-01.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 电压，
有触电危险。

注意： 产品上的这个标志意在提示用户设备随附的用户手册中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 
使用的特性等相关内容，敬请访问 Extron 网站 www.extron.com，参见 
Extron 安全规范指南，产品编号 68-290-01。

Chinese Traditional（  )

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 
可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有重
要的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資
訊，請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規
遵守手冊》，準則編號 68-290-01。

Japanese

警告: この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
いない高電圧が流れ、感電の危険があることを示しています。

注意:	 この記号  が製品上に表示されている場合は、本機の取扱説明書
に 記載されている重要な操作と保守(整備)の指示についてユーザーの 注
意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイト www.extron.com より 『Extron Safety 
and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고:  이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의: 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 
대한 자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 
규제 준수 안내서, 68-290-01 조항을 참조하십시오. 

Safety Instructions
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FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference. This interference must be corrected at the expense of the user.

ATTENTION: The Twisted Pair Extension technology works with unshielded twisted 
pair (UTP) or shielded twisted pair (STP) cables; but, to ensure FCC Class A and CE 
compliance, STP cables and STP Connectors are required.

For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the “Extron Safety and Regulatory 
Compliance Guide” on the Extron website.

Copyright
© 2014  Extron Electronics. All rights reserved.
Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks(®), registered service marks(SM), and trademarks(TM) are the property of 
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks (®)

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom, 
IP Link, Key Minder, LockIt, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, 
System INTEGRATOR, TeamWork, TouchLink, V‑Lock, VersaTools, VN‑Matrix,  VoiceLift, WallVault, WindoWall, XTP and XTP Systems

Registered Service Mark (SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu‑Rate Frame Lock), ADSP (Advanced Digital Sync Processing), Auto‑Image, CDRS (Class D Ripple Suppression), DDSP (Digital 
Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP (Digital Sync Validation Processing), 
FastBite, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, ProDSP, QS‑FPC (QuickSwitch Front Panel Controller), Scope‑Trigger, SIS, 
Simple Instruction Set, Skew‑Free, SpeedNav, Triple‑Action Switching, XTRA, ZipCaddy, ZipClip
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Conventions Used in this Guide

Notifications 
The following notifications are used in this guide:

WARNING: A warning indicates a situation that has the potential to result in death or 
severe injury. 

CAUTION: A caution indicates a situation that may result in minor injury.

ATTENTION: Attention indicates a situation that may damage or destroy the product or 
associated equipment. 

NOTE: A note draws attention to important information.

TIP: A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE: For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” represents the 
capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.

Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.
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XTP T UWP 302 • Introduction 1

Introduction

This section contains general information about this guide and the Extron XTP T UWP 302 
wallplate transmitter. Topics in this section include:

• About this Guide

• About the XTP T UWP 302

• Key Features

About this Guide
This guide contains installation, operation, and control procedures, and reference information 
for the XTP T UWP 302 wallplate transmitter. In this guide, the terms “XTP T UWP 302” and 
“transmitter” are used interchangeably to refer to the XTP T UWP 302 transmitter.

About the XTP T UWP 302
The Extron XTP T UWP 302 is a two-input transmitter that sends HDMI or RGBHV video, 
audio, and bidirectional RS-232 and IR up to 330 feet (100 meters) over a single CAT 5e, 
6, or 7 cable (CATx). This three-gang wallplate transmitter supports computer-video to 
1920x1200, including HDTV 1080p/60 Deep Color and 2K. The XTP T UWP 302 works 
with XTP Systems for signal distribution and long-distance transmission between remote 
endpoints.

The XTP T UWP 302 can be powered locally or remotely through an Extron Power Injector or 
XTP matrix switcher (see Power Connection on page 13).

To configure and control the XTP T UWP 302, connect a host device, such as a computer, 
and enter Simple Instruction Set (SIS) commands (see SIS Configuration and Control on 
page 17) or use the XTP System Configuration Software (see XTP System Configuration 
Software on page 22).
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Figure 1. Typical Point-to-Point Application Diagram
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XTP T UWP 302 • Introduction 2

Key Features
Wall mountable — Mounts in a standard three-gang junction box or the provided mud ring.

Inputs — Include one HDMI input and one VGA input.

Computer-video to 1920x1200 support, including HDTV 1080p/60 Deep Color and 
2K signals — Supports digital signal transmission up to 330 feet over a single twisted pair 
cable, maintaining superior image quality at the highest resolutions.

CAT 5e, 6, and 7 compatible — Optimized for use with common unshielded and shielded 
twisted pair cable types. XTP systems fully support a maximum transmission distance of  
330 feet (100 meters) for all compatible resolutions when used with CAT 5e, CAT 6, or  
CAT 7 twisted pair cable. Shielded twisted pair cabling with solid center conductor sizes of 
24 AWG or better is recommended for optimal performance.

Digital conversion of analog video and audio input signals — Digitizes analog signals, 
ensuring that a reliable, high quality digital video signal is sent to the output destination.

Auto-input switching — Automatically switches to the highest or lowest priority input with 
an active video signal for simplified operation.

Bidirectional RS-232 and IR insertion — Allows a remote display to be controlled without 
the need for additional cabling through bidirectional RS-232 control and IR signals inserted 
into the XTP output.

HDMI specification features — Include data rates up to 6.75 Gbps, Deep Color up to 12-
bit, 3D, HD lossless audio formats, and CEC pass-through.

HDCP-compliance — Ensures display of content-protected media and interoperability with 
other HDCP-compliant devices.

EDID Minder — Automatically manages EDID communication between connected devices 
to ensure that all sources properly power up and reliably display content.

Key Minder — Authenticates and maintains continuous HDCP encryption between input 
and output devices to ensure quick and reliable switching in professional AV environments, 
while enabling simultaneous distribution of a single source signal to one or more displays.

Supported HDMI specification features include data rates up to 6.75 Gbps, Deep Color up to 
12-bit, 3D, HD lossless audio formats, and CEC pass-through

Remote power capability — To simplify integration, the XTP T UWP 302 can be powered 
by an XTP CrossPoint matrix switcher or XTP Power Injectors.

Multiple embedded audio formats — Compatible with a broad range of multi-channel 
audio signals, providing reliable operation with HDMI sources.

Selectable analog stereo audio input embedding — Supports unbalanced audio for 
extended transmission. This feature enables direct connection of separate stereo audio 
signals from a laptop, Blu-ray Disc player, or other device.

RS-232 control — Features an RS-232 serial port for control and configuration.

Audio input gain and attenuation — Allows the level of gain or attenuation to be set, 
eliminating noticeable volume differences when switching between sources.

EDID and HDCP transmission — DDC channels are actively buffered, allowing continuous 
communication between source and display.
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XTP T UWP 302 • Installation and Operation 3

Installation and 
Operation

This section contains information for mounting, connecting, and wiring the XTP T UWP 302. 
Topics in this section include:

• Installation Overview

• Installing the Mud Ring or Junction Box

• Rear and Side Panel Connectors

• Mounting the XTP T UWP 302

• Front Panel Connectors

• Making Connections

• Operation

Installation Overview
The XTP T UWP 302 can be installed into the provided mud ring or an electrical UL Listed 
junction box.

1. Prepare the mounting surface.

CAUTION: Risk of personal injury. Failure to check the items listed below may result 
in personal injury.

ATTENTION: Failure to check the items listed below may result in property damage.

a. Ensure there are no utility cables or pipes at the intended location that might be 
damaged or cause injury when installing the device.

b. Check that the installation meets the building, electrical, and safety codes.

c. Ensure there is sufficient space behind the device.

d. Choose a location that will allow cable runs without interference.

NOTES: 

• Cables may need to be installed in the wall or conduits before installation.

• The mud ring does not require attachment to wall studs.

• For junction boxes, refer to the manufacturer for more installation requirements.

2. Cut a hole in the mounting surface (see Cutting an Opening in the Mounting Surface 
on page 4).

3. Install the mud ring or junction box in the mounting surface (see Installing the Mud Ring 
on page 4 or Installing the UL-Certified Junction Box on page 6).

4. Route and connect cables to the rear and side panel connectors (see Rear and Side 
Panel Connectors on page 6).

5. Mount the XTP T UWP 302 to the mud ring or junction box (see Mounting the  
XTP T UPW 302 on page 8).

6. Connect inputs to the front panel connectors (see Front Panel Connections on page 9).
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XTP T UWP 302 • Installation and Operation 4

Installing the Mud Ring or Junction Box

Cutting an Opening in the Mounting Surface
1. Using an appropriate template or the mounting enclosure as a guide, mark the area 

of the wall with a soft pencil that will be cut (for the provided mud ring, see Mounting 
Template on page 39).

NOTE: Check with the manufacturer of the junction box for specific installation 
requirements.

2. Use a jigsaw or small hand saw to carefully cut away the material within the guidelines 
drawn in step 1.

3. Check the size of the opening by laying the mud ring or junction box against it. The 
mounting device should fit snugly in the opening.

4. If needed, use a saw, file, or sandpaper to enlarge the hole.

CAUTION: Risk of personal injury. Smooth the edges of the opening to avoid 
personal injury during installation.

ATTENTION: Smooth the edges of the opening to avoid damage to the mounting 
device or the cables.

Installing the Mud Ring
The provided mud ring can be installed in two different ways depending on the width and 
type of mounting surface. Install the mud ring with backing clips for thin or less sturdy 
surfaces like wallboard, particle board, or soft wood. Install the mud ring directing into the 
wall with screws for sturdy or dense surfaces like sheet metal, plywood, or hard wood.

Fastening the mud ring with backing clips

Mounting Bracket

a

b

Figure 2. Installing the Mud Ring with Backing Clips

1. Place 1.25 inches (3.18 cm) long or 0.75 inch (1.90 cm) #6-32 thread machine screws 
through the middle holes in each corner of the mounting bracket. Use the shortest 
possible screw needed.

2. Loosely fasten the mounting backing clip on the end of each screw.
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XTP T UWP 302 • Installation and Operation 5

3. Insert the mounting bracket into the opening in the wall.

4. Rotate each backing clip so that the tab is behind the installation surface to hold the 
bracket snuggly in place when the screw is tightened.

Detail A

0.75" #6-32 Screw

Backing Clip Backing Clip

Mountint Surface Mounting Surface

Detail B

1.25" #6-32 Screw

Figure 3. Backing Clip Installation

NOTE: The backing clip can be installed in detail A or detail B (see figure 3).

5. Use a cross-head (Phillips) screwdriver to fasten the screws and backing clips in place.

Fastening the mud ring with screws

1. Insert the mounting bracket into the opening in the wall and hold it firmly in place.

2. Mark the locations of the outermost corner bracket holes on the installation surface.

b

d
Figure 4. Installing the Mud Ring Directly into the Mounting Surface

3. If desired, remove the mounting bracket and drill 0.25 inch deep pilot holes (half the 
width of the shaft of the screw) at the marked locations.

4. Use four 0.5 inch (1.3 cm) long, #6 flat headed wood screws to fasten the mounting 
bracket directly onto wood surfaces; or use self-tapping sheet metal screws to fasten 
the bracket to metal (see figure 4).

5. Hand tighten the screws.
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XTP T UWP 302 • Installation and Operation 6

Installing a UL-certified Junction Box
1. Insert the junction box into the hole in the wall.

2. Secure it to the stud using two screws or nails, as appropriate. The front edge of the 
junction box must be flush with the front surface of the wall.

3. Secure cables with clamps or ties to provide strain relief.

4. Trim back and insulate shields with heat shrink.

ATTENTION: To prevent short circuits, the outer foil shield can be cut back to the 
point where the cable exits the cable clamp. Both braided and foil shields should 
be connected to an equipment ground at the other end of the cable.

Rear and Side Panel Connectors

POWER
12V        
0.7A MAX

Tx Rx G

REMOTE
RS-232

X
TP

 O
U

T
S

IG
          LIN

K

Tx Rx G

OVER XTP
RS-232   IR

Tx Rx

bcd

a

Front Side

Figure 5. Rear Panel Connectors

a XTP Connector — Connect a twisted pair cable to the RJ-45 connector labeled  
XTP Out on the XTP T UWP 302 and the XTP input port on another XTP device to pass 
all signals (see TP Cable Termination and Recommendations on page 11). This 
cable carries the following signals:

• Digital video

• Digital audio

• Bidirectional RS-232 and IR commands

• Remote power

• Ethernet communication

• System communication

Signal LED indicator — Lights green when the transmitter outputs an XTP signal or 
test pattern to a compatible receiver or matrix switcher.

Link LED indicator — Lights yellow when XTP devices are connected and 
communication is established.

ATTENTION: 

• Do not connect this connector to a computer data or telecommunications 
network.

• XTP remote power is intended for indoor use only. No part of the network that 
uses XTP remote power should be routed outdoors (see Remote power on 
page 14).
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XTP T UWP 302 • Installation and Operation 7

b RS-232 Over XTP port — To pass bidirectional serial or other control signals between 
XTP-compatible devices, connect a control device to the 5-pole captive screw 
connector. The port includes only the 3 poles labeled “RS-232.”

IR Over XTP port — To transmit and receive IR signals (up to 40 kHz), connect a 
control device to the 5-pole captive screw connector. This port includes only the 2 poles 
labeled “IR” and shares the ground pole with the RS-232 port.

NOTE: RS-232 and IR data can be transmitted simultaneously (see  
RS-232 and IR Over XTP Communication on page 12 for wiring details). 

c Remote RS-232 connector — Connect a host device to the 3.5 mm, 3-pole captive 
screw connector for serial control of the transmitter.

d Power connector — Connect an external power supply to the 2-pole captive screw 
connector. The Power LED lights to indicate the device is receiving power.

NOTE: The XTP T UWP 302 can also be powered remotely (see Power 
Connection on page 13).

CONFIG

RESET

e

Figure 6. Side Panel Connector

e Config port — Connect a host device to the front panel mini USB Config port.
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Mounting the XTP T UWP 302

Backing Clip

Extron
XTP T UWP 302

AUDIO IN

PWR
HDCP HDMI VGA

HDMI IN

VGA IN

Figure 7. Installing the XTP T UWP 302 in the Provided Mud Ring

Wall Stud

Extron
XTP T UWP 302

AUDIO IN

PWR
HDCP HDMI VGA

HDMI IN

VGA IN

Figure 8. Installing the XTP T UWP 302 in a Junction Box

1. Align the mounting screws on the XTP T UWP 302 with the available holes on the mud 
ring or junction box.

2. Using the provided screws, attach the XTP T UWP 302 to the mud ring or junction box.
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Front Panel Connections

AUDIO IN

PWR HDCP HDMI VGA

HDMI IN
VGA IN

a b c
Figure 9. Front Panel Connectors

a HDMI connectors — Connect a digital video source device to the HDMI connector. It 
can accept HDMI, DVI, or dual mode DisplayPort video sources.

b Audio connector — Connect an analog audio source to the 3.5 mm tip-ring-sleeve 
(TRS) jack. 

Tip (+)

Sleeve (   )

Sleeve (   )

Ring (-)

Tip (+)

Audio Plugs.eps

RCA Connector

3.5 mm Stereo Plug Connector
(balanced)

Sleeve (   )

Ring (R)

Tip (L)

3.5 mm Stereo Plug Connector
(unbalanced)

Figure 10. Wiring for TRS Audio

By default, audio input is selected automatically (see Audio input selection SIS 
commands on page 19 to manually select audio inputs). When the HDMI input is 
selected with automatic audio input selections, the transmitter prioritizes embedded 
digital audio. The following table shows the audio format that is sent over the XTP 
connection when a specific audio format is not specified.

Selected 
Video Input

HDMI Embedded 
Audio Present

Analog Audio 
Present

Audio Sent Over XTP

VGA N/A Yes Analog audio

VGA N/A No No audio

HDMI Yes No HDMI embedded audio

HDMI Yes Yes HDMI embedded audio

HDMI No Yes Analog audio

HDMI No No No audio

c Analog video connector — Connect a video source to the female 15-pin HD 
connector. It accepts RGBHV video signals.
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Making Connections

HDMI Connection
Use an Extron LockIt Lacing Bracket to secure an HDMI cable to each connector as follows:

3

3

1

2

4

5

Figure 11. Installing the LockIt Lacing Bracket

1. Plug the HDMI cable into the panel connection.

2. Loosen the HDMI connection mounting screw from the panel enough to allow the 
LockIt lacing bracket to be placed over it. The screw does not have to be removed.

3. Place the LockIt lacing bracket on the screw and against the HDMI connector, then 
tighten the screw to secure the bracket.

ATTENTION: Do not overtighten the HDMI connector mounting screw. The shield 
it fastens to is very thin and can easily be stripped.

4. Loosely place the included tie wrap around the HDMI connector and the LockIt lacing 
bracket as shown (see figure 11).

5. While holding the connector securely against the lacing bracket, use pliers or similar 
tools to tighten the tie wrap, then remove any excess length.

Download from Www.Somanuals.com. All Manuals Search And Download.



 

XTP T UWP 302 • Installation and Operation 11

TP Cable Termination and Recommendations
Use the following pin configurations for twisted pair cables.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins:

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

Green

White-orange

Blue

White-blue

Orange

White-brown

Brown

Wire color
T568A T568B

White-orange

Orange

White-green

Blue

White-blue

Green

White-brown

Brown

Straight-through Cable
(for connection to a switch, hub, or router)

TIA/EIA-T568A TIA/EIA-T568B

Pin Wire Color Pin Wire Color

1 White-green 1 White-orange

2 Green 2 Orange

3 White-orange 3 White-green

4 Blue 4 Blue

5 White-blue 5 White-blue

6 Orange 6 Green

7 White-brown 7 White-brown

8 Brown 8 Brown

Figure 12. TP Cable Termination

Supported cables

The XTP T UWP 302 is compatible with CAT 5e, 6, 6a, and 7 shielded twisted pair (F/UTP, 
SF/UTP, and S/FTP) and unshielded twisted pair (U/UTP) cable. 

ATTENTION: 

• Do not use Extron UTP23SF-4 Enhanced Skew-Free AV UTP cable or STP201 cable 
to link the XTP products.

• To ensure FCC Class A and CE compliance, STP cables and STP connectors are 
required.

Cable recommendations

Extron recommends using the following practices to achieve full transmission distances up to 
330 feet (100 meters) and reduce transmission errors.

• Use the following Extron XTP DTP 24 SF/UTP cables and connectors for the best 
performance:

• XTP DTP 24/1000 Non-Plenum 1000’ (305 m) spool 22-236-03

• XTP DTP 24P/1000 Plenum 1000’ (305 m) spool 22-235-03

• XTP DTP 24 Plug Package of 10 101-005-02

• If not using XTP DTP 24 cable, at a minimum, Extron recommends 24 AWG, solid 
conductor, STP cable with a minimum bandwidth of 400 MHz.

• Terminate cables with shielded connectors to the TIA/EIA-T568B standard (see figure 12).

• Limit the use of more than two pass-through points, which may include patch points, 
punch down connectors, couplers, and power injectors. If these pass-through points are 
required, use CAT 6 or 6a shielded couplers and punch down connectors.

NOTE: When using CAT 5e or CAT 6 cable in bundles or conduits, consider the following: 

• Do not exceed 40% fill capacity in conduits.

• Do not comb the cable for the first 20 m, where cables are straightened, aligned, and 
secured in tight bundles.

• Loosely place cables and limit the use of tie wraps or hook and loop fasteners.

• Separate twisted pair cables from AC power cables.
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RS-232 and IR Over XTP Communication
The RS-232 and IR Over XTP connector is for pass-through transmission of serial signals, 
such as projector control signals, and Infrared data (see figure 13 for an example of how to 
wire the connector).

Tx/Rx
Pins

R
x

T
x

R
S

-2
32

R
x

T
x

TxRx

RxTx

Custom
IR Device

RS-232 Device

G

G

G

IR

Figure 13. Wiring the RS-232 and IR Over XTP Connector

ATTENTION: The length of exposed wires is critical. 

• The ideal length is 3/16 inch (5 mm).

• Longer bare wires can short together

• Shorter wires are not as secure in the connectors and could be pulled out.
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Power Connection
Apply power to the transmitter locally with the provided power supply or remotely with a 
power injector or an XTP matrix switcher.

ATTENTION: XTP remote power is intended for indoor use only. No part of the network 
that uses XTP remote power should be routed outdoors.

Local power

SECTION  A–A

AA

Power Supply
Output Cord

2-Pole Captive Screw
Connector

Ridges
Smooth

Tie Wrap

3/16”
(5 mm) Max.

Figure 14. Power Wiring

The XTP T UWP 302 can be connected to a local power supply.

WARNING: Electric shock hazard. The two power cord wires must be kept separate 
while the power supply is plugged in. Remove power before wiring.

ATTENTION:

• This product is intended to be supplied by a Listed Power Unit marked “Class 2” 
or “LPS,” rated 12 VDC, 1.0 A minimum. Always use a power supply supplied by 
or specified by Extron. Use of an unauthorized power supply voids all regulatory 
compliance certification and may cause damage to the supply and the end 
product.

• Unless otherwise stated, the AC/DC adapters are not suitable for use in air handling 
spaces or in wall cavities. The installation must always be in accordance with the 
applicable provisions of National Electrical Code ANSI/NFPA 70, article 75 and 
the Canadian Electrical Code part 1, section 16. The power supply shall not be 
permanently fixed to a building structure or similar structure.

• Power supply voltage polarity is critical. Incorrect voltage polarity can damage the 
power supply and the unit. The ridges on the side of the cord identify the power 
cord negative lead.

• The length of the exposed (stripped) copper wires is important. The ideal length is 
3/16 inch (5 mm).

TIP: Do not tin the stripped power supply leads. Tinned wires are not as secure in the 
captive screw connectors and could be pulled out.

Use the supplied tie wrap to strap the power cord to the extended tail of the connector.
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Remote power

The XTP T UWP 302 can be powered remotely through an XTP Power Injector or through 
an XTP matrix switcher.

ATTENTION: XTP remote power is intended for indoor use only. No part of the network 
that uses XTP remote power should be routed outdoors.

Power injector

To power the XTP T UWP 302 remotely with an XTP Power Injector, power one device 
locally (see Local power on page 13) and connect an XTP Power Injector to the XTP 
cable run along the XTP ports (see the XTP Power Injector User Guide for more installation 
information).

Extron 
XTP T UWP 302
Universal XTP Transmitter

POWER

12V

     
    

HDMI

--A
 MAX

Rx
G

Tx

RS-232 
IR

R

L

Rx
Tx

-
+

-
+

1

2

AUDIO

OFF

ON
AUDIO

S/PDIF

RESET

LAN
SIG     

     
    L

INK

XTP IN

OVER  X
TP

OUTPUTS

RELAYS

ACT     
     

  LINKSIG     
     

    L
INK

XTP IN

XTP

PWR

XTP PWR

100-240V
50/60 Hz

---A MAX

Extron
XTP R HDMI 
XTP Receiver

Extron
XTP PI 100 
XTP Power
Injector

CAT 5-Type
Cable

REMOTE
POWER

12V Local Power
Supply

AUDIO IN

PWR
HDCP HDMI VGA

HDMI IN

VGA IN

Figure 15. Typical Pont-to-point Application with Remote Power

NOTE: The power injector provides remote power up to 330 feet with a CATx cable with 
24 AWG wire.

Direct power from an XTP matrix switcher

XTP matrix switchers have a fixed amount of power available to provide remote power to 
connected XTP devices (see XTP matrix switcher use guide for more details). To manage 
available power from the XTP matrix switcher, use the XTP System Configuration Software 
on the XTP matrix switcher.
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Operation
After all transmitters, all receivers, and their connected devices are powered up, the system 
is fully operational. If any problems are encountered, verify that the cables are routed and 
connected properly. If problems persist, call the Extron S3 Sales & Technical Support 
Hotline. See the contact numbers on the last page of this guide for the nearest Extron office.

Indicators

AUDIO IN

PWR HDCP HDMI VGA

HDMI IN
VGA IN

a

Figure 16. XTP T UWP 302 Indicators

a Indicators

Power LED indicator — Lights when power is applied to the unit.

HDCP LED indicator — Lights when the input signal is encrypted.

HDMI LED indicator — Lights when the active input video signal is HDMI.

VGA LED indicator — Lights when the active input video signal is VGA.

EDID
To manage EDID on the XTP T UWP 302, use the XTP System Configuration Software (see 
XTP System Configuration Software on page 22). The XTP T UWP 302 can record and 
save EDID in a user memory location, select a pre-defined EDID, or use EDID from a display 
connected to a receiver. EDID stored in the user memory location can come from the display 
connected to a receiver or a custom EDID imported through the XTP System Configuration 
Software.

NOTE:     In matrix applications, EDID on the transmitter is assigned by the matrix 
switcher using the XTP System Configuration Software.
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Reset Modes
Use the recessed Reset button on the rear panel of the transmitter to return the device to 
default settings or to restore factory-shipped firmware. To access the Reset button, the  
XTP T UWP 302 may need to be removed from the mud ring or junction box.

Reset Mode Summary

Mode Activation Result Purpose/Notes

Fa
ct

o
ry

 R
es

et
  

(M
o

d
e 

1)

Press the recessed Reset button while 
applying power to the device.

NOTE: After a mode 1 reset, 
update the device with the 
latest firmware version. DO 
NOT operate the firmware 
version that results from this 
mode reset.

The device reverts to the factory 
default firmware.

NOTE: If you do not want to 
update the firmware or perform 
a mode 1 reset by mistake, 
cycle power to the device to 
return the firmware version 
running prior to the reset.

Use mode 1 to roll back 
to factory firmware for a 
single power cycle if an 
incompatibility issue arises.
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SIS Configuration 
and Control

The XTP T UWP 302 can be configured and controlled using Extron Simple Instruction 
Set (SIS) commands or the XTP System Configuration Software (see XTP System 
Configuration Software on page 22). This section contains basic SIS communication 
details and SIS commands and responses when connected directly to the XTP T UWP 302. 
Topics in this section include:

• Host Device Connection

• SIS Programming Guide

• Command and Response Tables for SIS Commands

Host Device Connection
Use a computer running the HyperTerminal or Extron DataViewer utility, or a control system 
to enable serial control of the transmitter. To connect directly to an XTP T UWP 302, 
connect the computer to the XTP T UWP 302 through the side panel USB Config port or 
the rear panel RS-232 connector. The protocol for the serial port is as follows: 9600 baud, 
no parity, 8 data bits, 1 stop bit, no flow control.

SIS Programming Guide

Host-to-Device and Device-to-Host Communication
SIS commands consist of one or more characters per field. No special characters are 
required to begin or end a command sequence. When the XTP T UWP 302 determines that 
a command is valid, it executes the command and sends a response to the host device. All 
responses from the switcher to the host end with a carriage return and a line feed  
(CR/LF = ]), which signals the end of the response character string. A string is one or more 
characters.

Device-Initiated Message
When the transmitter is connected through the serial port only and a local event occurs, the 
device responds by sending a message to the host. 

The following copyright messages are displayed after a power cycle via RS-232. The 
specific message displayed depends on the XTP T UWP 302 model.

© Copyright 2013, Extron Electronics XTP T UWP 302 Vx.xx, 60-1358-12]

© Copyright 2013, Extron Electronics XTP T UWP 302 Vx.xx, 60-1358-13]
Vx.xx is the firmware version number.
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Error Responses
When the XTP T UWP 302 receives an SIS command and determines that it is valid, it 
performs the command and sends the corresponding response to the host device. If the 
command is determined invalid or contains invalid parameters, the switcher returns an error 
response to the host. The error response codes are:

E01 = Invalid input number E12 = Invalid port number

E06 = Invalid switch attempt in this mode E13 = Invalid parameter

E10 = Invalid command E14 = Not valid for this configuration

E11 = Invalid preset number E17 = Invalid command for signal type

Using the Command and Response Tables for SIS Commands
The command and response tables begin on page 20. Figure 17 shows the hexadecimal 
equivalent of ASCII characters used in the command and response tables.

NOTE: Upper and lowercase text can be used interchangeably unless otherwise stated.

ASCII to Hex Conversion Table

•

Space

Figure 17. ASCII to Hexadecimal Conversion

Symbol Definitions

] = Carriage return and line feed

| or } = Carriage return with no line feed

• = Space

E or W = Escape key
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Command and Response Tables for SIS Commands

Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Input Commands
Input selection

Select input X!! InX!] Select input X!.

View the selected input ! InX!] View the selected input.

Auto switch mode

Disable auto switch mode E0AUSW} Ausw0] Switch inputs manually (default).

Set priority to the highest 
numbered active input

E1AUSW} Ausw1] Automatically switch to the highest 
numbered active input.

Set priority to the lowest 
numbered active input

E2AUSW} Ausw2] Automatically switch to the lowest 
numbered active input.

View setting EAUSW} AuswX#] View the auto switch mode.

Audio Configuration Commands
Audio gain and attenuation

NOTE:   Gain and attenuation commands are case-sensitive.

Set gain X%G AudX&] Set gain to X%.

Set attenuation X^g AudX&] Set attenuation to X^.

Increment audio level +G or +g AudX&] Increase the audio level.

Decrement audio level -G or -g AudX&] Decrease the audio level.

View audio level G or g AudX&] View the audio level.

Audio input selection

Set audio input format EIX@AFMT} AfmtIX@] Set the audio input format to X@.

View audio input format EIAFMT} AfmtIX@] View the audio input format.

Black video signal resolution

Set black signal resolution EAX*AFMT} AfmtAX*] Set the black signal resolution to X*.

View black signal resolution EAAFMT} AfmtAX*] View the black signal resolution.

NOTE: X! = Input selection                                             1 = VGA (default) 
                                                                            2 = HDMI 
X@ = Audio input format                                       0 = auto (default) 
                                                                            1 = digital embedded 
                                                                            2 = analog 
X# = Auto switch mode                                       0 = disable (default) 
                                                                            1 = priority to the HDMI input (default) 
                                                                            2 = priority to the VGA input 
X% = Audio gain adjustment                                 0 - 24 = decibels above 0 
X^ = Audio attenuation adjustment                      –18 - 0 = decibels below 0 
X& = Audio level adjustment                                 –18 - +24 (0 dB = default) 
X* = Black signal resolution                                 2 = 720p @ 50 Hz 
                                                                            4 = 720p @ 60 Hz (default) 
                                                                            6 = 1080p @ 60 Hz
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Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Black signal for audio only

NOTE: The switcher uses a black signal to simulate a 720p or 1080p, 50 Hz or 60 Hz signal so audio can be 
passed without video.

Enable black signal EB1AFMT} AfmtBX(] Enable a black signal for audio 
only.

Disable black signal EB0AFMT} AfmtBX(] Disable the black signal.

View black signal setting EBAFMT} AfmtBX(] View the black signal setting.

Picture Adjustment Commands
Pixel phase

Set a pixel phase value EX1#PHAS} PhasX1#] Adjust the pixel phase to X1#.

Increment value E+PHAS} PhasX1#] Increase the pixel phase value.

Decrement value E-PHAS} PhasX1#] Decrease the pixel phase value.

View pixel phase value EPHAS} PhasX1#] Show the pixel phase value.

Horizontal shift

Set horizontal shift value EX1$HCTR} HctrX1$] Set the horizontal location of 
the first active pixel in the active 
window.

Increment value E+HCTR} HctrX1$] Increase the shift value.

Decrement value E-HCTR} HctrX1$] Decrease the shift value.

View horizontal shift value EHCTR} HctrX1$] Show the horizontal location of 
the first active pixel in the active 
window.

Vertical shift

Set vertical shift value EX1$VCTR} VctrX1$] Set the vertical location of the first 
active pixel in the active window.

Increment value E+VCTR} VctrX1$] Increase the shift value.

Decrement value E-VCTR} VctrX1$] Decrease the shift value.

View vertical shift value EVCTR} VctrX1$] Show vertical location of the first 
active pixel in the active window.

Preset Commands
Input presets

Save an input preset X1%, SprX1%] Save the current configuration to 
preset X1%.

Recall an input preset X1%. RprX1%] Recall the preset X1% 
configuration.

NOTE: X( = Enable or disable                                         0 = disable 
                                                                            1 = enable (default) 
X1# = Pixel phase                                                0-255 (128 = default) 
X1$ = Horizontal or vertical shift                           0-65535 (32768 = default) 
X1% = Preset number                                           1-8

Download from Www.Somanuals.com. All Manuals Search And Download.



 

XTP T UWP 302 • SIS Configuration and Control 21

Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

EDID Commands

NOTE: For EDID management, use the XTP System Configuration Software (see EDID Minder on page 33).

Advanced Configuration Commands
HDCP authorized device (HDMI input only)

HDCP authorized device On EE1HDCP} HdcpE1] HDCP authorized device on 
(default).

HDCP authorized device Off EE0HDCP} HdcpE0] HDCP authorized device off.

Query HDCP authorized 
device status

EEHDCP} HdcpEX$] View the HDCP authorized 
device status.

Test pattern

Set a test pattern X1)J TstX1)] Set a test pattern or disable 
one.

View the current test pattern J TstX1)] View the current test pattern.

Factory defaults

System reset EZXXX} Zpx] Resets unit to factory default.

Status

View input signal presence 0LS FrqX1!X1!] View the input signal presence 
of each input.

Query HDCP input EIHDCP} HdcpI0X1@] View the HDCP status of the 
HDMI input.

Query firmware version Q x.xx] View the firmware version.

Query full firmware version *Q x.xx.xxxx] View the full firmware version.

Query part number N 60-1358-12] or 
60-1358-13]

View the device part number.

NOTE: X! = Input selection                                             1 = VGA (default) 
                                                                            2 = HDMI 
X$ = HDCP Authorization                                     0 = HDCP authorization off 
                                                                            1 = HDCP authorization on (default) 
X1) = Color bar test pattern                                0 = disable (default) 
                                                                            1 = 720p @ 50 Hz 
                                                                            3 = 720p @ 60 Hz 
                                                                            5 = 1080p @ 60 Hz 
X1! = HDCP status                                             0 = no source connected 
                                                                            1 = HDCP compliant source 
                                                                            2 = non-HDCP compliant source 
X1@ = Video signal status                                     0 = video or TMDS not detected 
                                                                            1 = video or TMDS detected
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XTP System 
Configuration 
Software

This section contains installation and configuration procedures for the XTP System 
Configuration Software for configuring and controlling the XTP T UWP 302. Topics in this 
section include:

• Installing the XTP System Configuration Software

• Using the XTP System Configuration Software

Installing the XTP System Configuration Software
The program is available for download on the Extron website, www.extron.com. 

Figure 18. Extron Website Download Page

1. On the Extron website, click the Download tab.

2. From the left sidebar, click the XTP System Configuration Software link.

3. Click the Download Now button.

4. Submit any required information to start the download. Note where the file is saved.

5. Open the executable (.exe) file from the save location.

6. Follow the instructions that appear on the screen. By default, the installation creates a 
directory in the Program Files folder, and places four icons into a group folder named 
“Extron Electronics\XTP System Configuration.” 
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Using the XTP System Configuration Software
The XTP T UWP 302 can be controlled directly from the side panel config port or remotely 
from an XTP matrix switcher. 

Connections
When opening the XTP System Configuration Software, the Connections screen opens first. 
This screen is used to establish communication with an XTP device USB (see Config port 
on page 7).

Figure 19. Connections Screen

1. From the Connections screen, select the USB radio button.

2. Select the connected device to be controlled from the displayed list.

3. Click the Connect button.
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Top Menu
The top menu bar contains three menus for configuring software settings.

File menu

The File menu contains options for disconnecting and exiting the program. To access the 
menu, click the File menu.

Figure 20. File Menu

Disconnect

This option disconnects the XTP System Configuration Software from the connected device. 

From the File menu, select Disconnect. The Connections screen opens.

NOTE: If the device is already disconnected, the Disconnect option is disabled until a 
device is connected.

Exit

This option disconnects the receiver from the software and closes the application.

From the File menu, select Exit. The application closes.

Tools menu

The Tools menu contains an option for updating firmware. To access this menu, click the 
Tools menu.

Figure 21. Tools Menu

NOTE: The Backup and Restore and Software Preference options are not 
available when directly connected to the XTP T UWP 302.
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Update Firmware

This option uploads firmware from the host device to the connected device.

NOTE: If necessary, download new firmware from the Extron website (see 
Downloading Firmware on page 37).

1. From the Tools menu, select Update Firmware. A dialog box opens to ask permission 
to disconnect from the device.

Figure 22. Confirm Disconnect Dialog Box

2. Click the Yes button to disconnect from the device and continue with the firmware 
update process. The Update Firmware dialog box opens.

Figure 23. Update Firmware Dialog Box

3. Click the Check network for updates icon to search the LAN or WAN for firmware 
files or click the Select file from computer icon to select a firmware file from the 
connected host device.

4. Select the desired firmware file and click the Close button after the firmware finishes 
updating.
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Help menu

The Help menu contains XTP System Configuration Software information, the help file, and 
a link to the Extron website.

Figure 24. Help Menu

About the Software

This option provides basic information about the XTP System Configuration Software, 
including version number and copyright information.

Figure 25. About Dialog Box (Example)

1. From the Help menu, select About the Software. The About - XTP dialog box opens.

2. Click the Details button for more information.

3. Click the Ok button to close the dialog box.

Help

This option opens the XTP System Configuration Software help file in a Web browser.

From the Help menu, select Help.

Extron Website

This option opens the Extron website in a Web browser.

From the Help menu, select Extron Website.
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Device Settings
The Device Settings screen allows a user to view and edit various device settings for the 
device directly connected to the host device. Click the Device Settings icon on the 
Global Navigation bar to open the Device Settings screen.

Figure 26. Transmitter Device Settings Screen

AV Controls panel

The AV Controls panel, located on the left, is used to selection an input 
and apply one-time Auto-Image to input 1. 

Auto-Image — Click the Auto-Image button to start a one-time  
Auto-Image on the currently selected input.

Input selection — Click an Input button to select an input. As a new 
input is selected, the summary within the device information panel 
changes to reflect the currently selected input.

NOTE: The signal indicators on the AV input buttons display 
green when a signal is present on the corresponding input or 
gray when there is no signal present.
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Input/Output tab

Click the Input/Output tab to open the Input/Output screen. It contains input information 
and options to apply automatic settings to individual inputs.

Figure 27. Input/Output Tab

Input name — Displays the input name.

Signal type — Displays the signal type of each input. Input 1 is analog. Input 2 is  
HDMI/DVI.

Auto-Image — Select the Auto-Image check box of input 1 to apply an automatic  
Auto-Image. When selected, Auto-Image is applied whenever there is a change in the input 
sync. Auto-Image attempts to size and center the input signal based on the aspect ratio 
setting.

Auto Memory — Select the Auto Memory check box of input 1 to enable the Auto 
Memory. Auto Memory recalls input and image settings for signals that have previously been 
applied. When it is disabled, the XTP T UWP 302 treats every newly applied input as a new 
source.

HDCP authorization — Select either HDCP Authorized check box to have input 2 report 
as an HDCP authorized device. If the box is not checked, the source will be blocked from 
encrypting its output. This may result in some content not being passed by the source 
device.
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Analog Video tab

Click the Analog Video tab to open the Analog Video screen. It contains signal sampling, 
image shifting, and saving and recalling input preset options.

Figure 28. Analog Video Tab

Signal Sampling panel

Signal sampling optimizes the input signal to the transmitter for the currently selected input.

To adjust signal sampling settings, enter a value within acceptable range displayed in 
parentheses to the right of the corresponding field or click the Up and Down arrows.

Shift panel

Shifting moves the position of an image.

To adjust the horizontal and vertical shift settings, enter a value within the Min and Max 
values displayed to the right of the corresponding field or click the Up or Down arrows.

Input Presets panel

Input presets save signal sampling and shift settings to be recalled later.

Save presets — To save a preset, select one from the list of presets and click the Save 
Preset button.

Recall presets — To recall a saved preset, select the desired preset from the list of presets 
and click the Recall Preset button.
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Audio tab

Click the Audio tab to open the Audio screen. It contains settings for input format and 
analog audio gain.

Figure 29. Audio Tab

Input format section

Input format — From the Audio Format drop-down list, select the format for input 2. It 
can be Auto, HDMI, or Analog.

Analog audio gain — Click and drag the handle of the Gain slider, enter a value in the 
field, or click the Up or Down arrow to adjust the analog input gain.
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General tab

Click the General tab to open the general screen. It contains settings for executive mode, 
auto switch mode, and factory reset.

Figure 30. General Tab

Executive mode section

Unlock the front panel — Click the Unlock Front Panel radio button (default) to disable 
executive mode. 

Lock the front panel — Click the Lock Front Panel radio button to enable executive 
mode.

Auto-input Switching section

Auto-input switching — Click the Enable Auto-Input Switching check box to enable 
auto switch mode. Two settings are available for this mode.

Click the Priority to highest active input number radio button to automatically 
switch to the highest numbered active input.

Click the Priority to lowest active input number radio button to automatically 
switch to the lowest numbered active input.

Factory reset

Click the Factory Reset button to reset the transmitter to factory settings except for 
firmware.

NOTE: This is the same as the EZXXX SIS command (see the System reset 
command on page 21).
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Device Information panel

The Device Information panel displays device 
information and settings. 

General Information section 

Model — Displays the device model.

Firmware version — Displays the full firmware 
version.

Signal Information section

Selected input — Displays the input number of  
the currently selected input.

Auto-input switching — Displays the On or Off 
status of auto switch mode.

Signal present — Displays the signal presence  
of both inputs.

HDCP — Displays the HDCP status of inputs 2.

Audio Information section 

Selected audio input — Displays the format of the currently selected audio input.

Analog audio gain — Displays the analog audio gain in dB.
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EDID Minder

Use the EDID Minder screen to assign unique EDID to the input or match current output 
resolutions to the input. Click the EDID Minder icon on the global navigation bar. The  
EDID Minder screen opens.

The EDID Minder screen displays a table of EDID options and connected output devices, 
which are each represented by output display icons.

• Factory default EDID options are displayed in blue.

• Connected output resolutions and devices are displayed in green. 

• Custom loaded or saved EDID options are displayed in yellow. 

Figure 31. EDID Minder Screen

Assign EDID

To assign EDID to selected inputs:

1. Select an available EDID setting (represented by a blue, green, or yellow output display 
icon) from the Available EDID pane.

2. In the list of inputs on the right side of the screen, select the check box of the 
connected input.

3. Click the Assign button below the input area.

TIP: Alternatively, EDID can be assigned by dragging and dropping the desired EDID 
onto the input.

To assign EDID to all inputs:

1. Select an available EDID setting (represented by a blue, green, or yellow output display 
icon) from the Available EDID pane.

2. Below the list of inputs on the right side of the screen, click the Assign to All button.
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Import EDID

1. On the EDID Minder screen, click the Add EDID to Library button.

2. Select the desired EDID file and click Open. The EDID appears in the Available EDID 
pane.

3. Assign the EDID from the Available EDID pane to import the EDID setting to the device.

Save output EDID

1. On the EDID Minder screen, right-click on the desired EDID setting in the Connected 
Outputs pane.

2. Select the Save EDID to PC option. The EDID setting is saved to the connected PC. 
Alternatively, right-click on the desired EDID, select Copy, and then Paste the EDID into 
the desired pane.

Set favorite EDID

Commonly used EDID settings can be added to the Favorites pane for quick access.

1. Click and drag the desired EDID to the Favorites pane. The EDID setting is copied to the 
Favorites pane. Alternatively, right-click the desired EDID and select Copy. Then Paste 
the EDID setting into the Favorites pane.

EDID filters

The filters can be used to easily and quickly locate specific EDID. Selectable filters include:

• Resolution

• Refresh rate

• Audio format

• Video format

Figure 32. EDID Minder Filters

To use a filter or combination of filters:

1. Select an EDID setting from one of the drop-down lists of the associated filter. The 
available EDID options that match the filter selection are displayed in the Available EDID 
pane.

2. Repeat step 1 to apply more filters.

To clear the currently applied filters:

1. Click the Clear button next to the filters. All filters are reset.

Common timings

This function automatically displays available EDID settings that are common among 
multiple selected outputs.

1. Hold <Ctrl> and click the desired outputs in the Connected Outputs pane. The Common 
Timings tab appears, listing the EDID settings common among the selected outputs.

2. Select the desired common EDID setting. The EDID will be shown in the Available EDID 
pane.
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Reference 
Information

This section contains mounting information and instructions for updating firmware. Topics in 
this section include:

• Updating Firmware with Firmware Loader

• Mounting Template

Updating Firmware with Firmware Loader
To upload and update firmware for the XTP T UWP 302, download the new firmware to a 
connected computer and upload the firmware with the Firmware Loader utility.

Downloading Extron Firmware Loader

Figure 33. Locating Software on the Extron Website

1. On the Extron website, click the Download tab.

2. On the left sidebar, click the Software link.
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Figure 34. Navigating to Firmware Loader

3. Navigate to Firmware Loader.

4. Click the Download link on the right that corresponds with the program.

5. Submit any required information to start the download. Note where the file is saved.

Installing Firmware Loader
1. Once Firmware Loader has been downloaded, run the .exe file from the save location. 

The installation wizard window opens.

2. Follow the instructions on the Installation Wizard screens to install Firmware Loader on 
the computer.
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Downloading Firmware

Figure 35. Downloading Firmware from the Extron Website

1. On the Extron website, click the Download tab.

2. On the left sidebar, click the Firmware link.

3. Navigate to the XTP T UWP 302.

4. Ensure the available firmware version is a later version than the current one on the 
device.

NOTE: The firmware release notes are a PDF file that provides details about the 
changes between different firmware versions. The file can be downloaded from the 
same page as the firmware.

5. Click the Download link to the right of the desired device.

6. Submit any required information to start the download. Note where the file is saved.
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Installing Firmware with Firmware Loader
Use the Firmware Loader utility to upload firmware to the transmitter when connected 
directly to the device.

1. Connect the host device to the side panel USB port.

2. Open Firmware Loader and establish a connection between the computer and the 
device. The Add Device... dialog box opens.

Figure 36. Add Device... Dialog Box

3. Select XTP T UWP 302 from the Device Name drop-down list.

4. Select the method of connection from the Connection Method drop-down list.

5. Depending on the connection method, additional options appear. Make the appropriate 
selections for the current connection method.

6. Click the Connect button.

7. Click the Browse button in the New File Firmware (Optional) section.

8. On the Open dialog box, navigate to the new firmware file, which has an .S19 extension, 
and click the Open button.

ATTENTION: Valid firmware files must have the file extension .S19. A file with any 
other extension is not a firmware upgrade for this device and could cause the 
device to stop functioning.

9. Click the Add button. The Add Device... dialog box closes and the device and firmware 
are listed in the Firmware Loader main window.

10. Click the Begin button to start the upload process.

11. Close Firmware Loader when the Remaining Time field shows 00.00.00, the 
Progress column is 100%, and the Status field is completed.
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Mounting Template
Figure 37 is a example of a mounting template for preparing mounting surfaces. It is not to 
full size.

Template for the 3-gang  
mounting bracket 

6.41" (16.3 cm) 

4.50" 
(11.4 cm) 

TEMPLATE IS NOT FULL SIZE. 

Recommended 
cut-out area 
for  the installation 
surface. 

Top Panel 

SURFACE 
CUT-OUT AREA 

FOR WALL MOUNT  

5.61" (14.2 cm) 

3.88" 
(9.9 cm) 

Figure 37. Mounting Template for 3-gang Mud Rings
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Contact Information

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE: If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA: 714.491.1500 or 800.633.9876 Europe: 31.33.453.4040  
Asia: 65.6383.4400 Japan: 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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